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1 Introduction

Welcome to the Viz Trio User Guide.

1.1 What Is Trio?

Viz Trio contains all the features of a typical CG (Character Generator) system and more. Viz
Engine is the graphics rendering output system and Media Sequencer controls the playout of
media elements.

With Viz Trio you can:

- Trigger graphical elements stored as pages in a show structure, with each page utilizing a
unique call-up code.
Fill in data fields for graphics.
Quickly import or reimport new graphics into a show, no need for a template redesign,
everything happens automatically.
Use Trio as a clip player with a timeline editor.
Customize the Trio interface through scripting and macro commands.
Use Trio as a graphics playout server, integrating from a third party system through macro
commands over TCP/IP.
Let data update live through Datacenter without any scripting or advanced design.

Advanced features let you connect to multiple newsroom systems, do seamless context switches
on graphics (Transition Logic), use specialized editors that can change almost any property of a
graphic, produce on-the-fly graphics with a built-in design tool, and more.

& Note: The Viz Trio client can run on any computer that has a network connection to Media
Sequencer. For the local preview to function properly, the computer must have a good
Nvidia GPU.

1.2 System Overview - Basic Setup

Media Sequencer

(@ Info: The system overview above shows a basic setup. Viz Engine is typically used for local
preview.

- The Trio operator creates pages, most often from pre-made templates. A page is an instance
of a template that can be customized with data values, like sports results or election data.

Copyright © 2023 Vizrt Page 9
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- When the page is ready, the Trio operator can easily send pages with the necessary
information to air.
Viz Trio automatically uses Media Sequencer to trigger final rendering of the output by the
Viz Engine.

& Note: Although Viz Trio, Media Sequencer and Viz Engine can be installed and operated on
a single machine, they are mostly installed on separate servers for performance and
security reasons.

Viz Trio can also interface with other systems for news feed and media resources, for
instance MAM systems such as Viz One for video and media resources and Viz Pilot.
Social Media feeds and news can be interfaced and ingested in the workflow with the Viz
Social solution.

1.3 System Overview - Advanced Setup

An advanced setup with newsroom and video integration involves several other Vizrt
products such as a Vizrt MAM system, Viz Pilot, Viz Gateway and third-party systems such as
a newsroom and database system.

Viz Gateway can be used to connect Viz Trio to most Newsroom systems using the MOS
protocol.

& Note: Director from Viz Pilot can also be used as the control application.

1.4 Related Documents

Viz Artist User Guide: How to create standalone and transition logic scenes.

Viz Pilot User Guide: How to create a playlist in Viz Pilot that can be monitored in Viz Trio,
and use the Newsroom Component to create newsroom data elements for a newsroom
system playlist.

Viz Engine Administrator Guide: How to configure your Viz Engines.

Viz One Administrator Guide: How to configure your Viz One system.

Viz One - Studio User Guide: How to work with your Viz One system.

1.5 Feedback

We encourage feedback about our products and documentation. Please contact your local Vizrt
customer support team at www.vizrt.com.

See Also

Glossary

Copyright © 2023 Vizrt Page 10
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2 Requirements And Installation

The following sections describe the steps required to have a multi-client Viz Trio setup with a
remote Media Sequencer connected to one or several Viz Engine output renderers.

© IMPORTANT! Always check the release notes for information on supported versions of
software, hardware requirements and last-minute updates.

This section covers the following topics:

Requirements
Installation
Upgrading Viz Trio

2.1 Requirements

This section covers the following topics:

Prerequisites
General Requirements
Hardware Requirements
Software Requirements
- Media Sequencer
- Viz Pilot
Viz Trio Keyboard

2.1.1 Prerequisites

Before installing a Viz Trio system, make sure that the correct hardware and latest software is
available. All Vizrt software required is accessible from Vizrt’s FTP server at download.vizrt.com.
Contact your local Vizrt representative for credentials.

2.1.2 General Requirements

There are some general requirements for any Vizrt system to run, which apply when setting up a
complete system with integration to other Vizrt and third party software:

- All machines should be part of the same domain.
Users of the Vizrt machines should ideally be separated into at least two groups -
administrators and designers/operators.
Most machines running desktop applications must be logged in with sufficient privileges to
run Vizrt programs, while services by default do not require users to be logged in.

- Vizrt servers must have static IP addresses.

- Vizrt recommends that customers who use remote shares for storing data use UNC
(Universal Naming Convention) paths directly in the configuration, rather than mapped
drives. For example: \vosstore\images.

Copyright © 2023 Vizrt Page 11
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- Vizrt has license restrictions on all Viz Engine and Viz Artist instances. To have an output of
Vizrt generated graphics (preview and program channels), a WIBU license is required.

© Caution: Third party systems that provide Vizrt systems with files must only use Microsoft
Windows operating system compatible characters in file names.

2.1.3 Hardware Requirements

In general, Viz Trio hardware requirement should match the hardware requirement for a preview
version of the Viz Engine. See Viz Engine release notes for supported hardware.

& Note: For more information on hardware specifications, please contact your local Vizrt
customer support team.

2.1.4 Software Requirements

Recommended Versions

Operating Systems
- Windows 10

Software

- Viz Engine 4.4.1
- VizOne 7.3.2
- Graphic Hub 3.6.0 (optional with Graphic Hub REST 2.6.0).
- Media Sequencer 5.4.0
- Viz Engine 4.4.1
Pilot Data Server 8.9.

Viz Engine

Viz Engine is the output service (renderer) for Viz Trio, and is a separate installer. A Viz Engine is
required in order for Viz Trio to preview graphics. Check that Viz Engine is installed, configured
and working before installing and using Viz Trio.

After installing Viz Engine, make sure to also install any additional plug-ins, such as Viz Datapool.
The plug-ins required will vary depending on the scene design and integrations.

To install Viz Engine, refer to the instructions in the Viz Engine Administrator Guide.

2.1.5 Media Sequencer

Media Sequencer is in most cases installed on a server acting as a middle tier between Viz Trio and
Viz Engine.

Copyright © 2023 Vizrt Page 12
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Installing Media Sequencer

1. Run the installer and follow the directions given by the installation wizard.
2. Optional: Install the Oracle 10g Runtime Client.
Restart Media Sequencer after installing the database client.
- A database client is needed when connected to Viz Gateway for accessing the Viz Pilot
database.

2.1.6 Viz Pilot

In order to edit Pilot Edge elements in Trio, Media Sequencer must be configured to connect to a
Pilot Data Server. This server hosts Pilot Edge, which is opened by Trio in a web browser window.

To configure Media Sequencer to use a Pilot Data Server, go to File > Configuration > Pilot
Database in Trio and open the configuration page.

2.1.7 Viz Trio Keyboard

To install the Viz Trio keyboard, the keyboard’s USB connector must be connected to the
computer’s USB port. The computer should be able to detect and automatically install required
keyboard drivers.

& Note: To learn more about the keyboard’s technical specifications, visit http://
www.devlin.co.uk/keyboards/semicust.html DevlinGroup - Devlin Electronics Limited.

Importing the Keyboard Mapping File

1. Open Viz Trio and click the Show properties button.

2. In the Show properties window that opens, click the Keyboard button.

3. In the Macros for Current Show window that opens, click Import.

4. In the Import keyboard shortcuts dialog that opens, click the folder button to browse for and
import the keyboard file (extension *.kbd).

Optional: Select to merge the existing keyboard shortcuts with the new ones.

Click Import.

[e)E; ]

See Also

- Viz Pilot Database

2.2 Installation

2.2.1 Installing Viz Trio

1. Make sure you have the correct hardware and software platform.
2. Ensure that Viz Engine is installed and that you have a working local Graphic Hub and Media
Sequencer or have network credentials to the Graphic Hub and Media Sequencer.
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3. Download the latest Viz Trio installer and Release Notes with FTP from download.vizrt.com/
products/VizTrio/LatestVersion/.

4. Read the Release Notes carefully. They may contain important last minute information.

5. Double-click the downloaded installer and follow the installation instructions.

6. Visit docs.vizrt.com to learn more about the software or press F1 / Help > View Help to
browse the local help.

© IMPORTANT! You can only have one Trio installed on a computer. If you have a previous
version of Trio installed, the previous version will be overwritten by the new Trio installer,
which will attempt to preserve most data/configuration settings.

2.3 Upgrading Viz Trio

The latest version of Trio should be backwards compatible with Trio shows created from 2.12 and
forward. After installing Trio client, settings, profiles and shows should remain exactly as they
were.

To make sure data is not lost, please consider taking a backup of the Media Sequencer's
default.xml file before upgrading.
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3 Configuration

Connect Viz Trio to Media Sequencer and Viz Engine, and set up Viz Trio for playout.

& Note: Before starting the Viz Trio client, make sure that Media Sequencer, Viz Engine and
Graphic Hub have been installed, and are running and configured.

This section covers the following topics:

License, Hardware and Startup
- Trio OneBox

Configuration Window

Command Line Parameters

3.1 License, Hardware And Startup

Viz Trio needs a connection to Media Sequencer and a local Viz Engine in order to
start successfully.

This section covers the following topics:

Hardware Configurations
Preview/Program Configuration

- Viz Trio OneBox Configuration

Connecting to Media Sequencer

Connecting to Viz Engine

- Administrator mode
License
Ports

3.1.1 Hardware Configurations

Preview/Program Configuration

Traditionally, each Viz Trio system has required two standard desktop PCs to operate: one for the
Viz Trio client and one for its renderer Viz Engine.

Viz Trio OneBox Configuration

You can also run a complete Viz Trio system, including the Viz Engine, on a single standard PC
(desktop or rack mountable) with all the features of a conventional Viz Trio setup. Two powerful
graphics cards ensure the same graphics quality and rendering speed. Both the VGA preview and
final program signals (playout) can be viewed on the same machine.
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@ Tip: The single computer setup is suitable when you have limited space, such as in mobile
environments (OB vans and remote broadcasts) and small studios.

3.1.2 Connecting to Media Sequencer

Parameters in the program target path determine the connection a Viz Trio client has to Media
Sequencer. If no Media Sequencer target path parameter is set, Viz Trio will default to a local
Media Sequencer.

To connect to a different Media Sequencer, right-click the Viz Trio desktop shortcut on the
Windows desktop and set a parameter for the -mse setting in the Target path.

() Example: C:\Program Files (x86)\vizrt\Viz Trio\trio.exe -mse localhost -control -lang en
-loglevel 5

3.1.3 Connecting to Viz Engine

Viz Trio needs a local Viz Engine in order to run previews and import scenes. Viz Trio
automatically detects and runs Viz Engine.

& Note: The same Viz Engine version must be installed on all machines and they must
connect to the same Graphic Hub.

3.1.4 Administrator mode

Trio must be started in Administrator mode.

3.1.5 License

The local Viz Engine, Viz Trio and Datacenter must be licensed through CodeMeter from WIBU
systems. The CodeMeter runtime service must be running on the local Trio host. CodeMeter is
bundled with the local preview Viz Engine and the Trio client installer. When retrieving the license
from a dedicated license server, it must be configured in the Vizrt Licensing Service (see the Client
Configuration page in the License Server Setup and Administration section of the Vizrt Licensing
Administrator Guide) or the CodeMeter WebAdmin.

When Trio starts up for the first time, a dialog box prompts you to select among available license
containers, locally and from the configured licenser server(s) on the network:
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*:'; Trio license configuration
Please select a container with available Trio licenses.
Container Available licenses Expiration dat

130-755289660 (Metwork license) 11/30/2022
3-4589731 (Network license) 43002023

r WebAdmin

Teo guit Trie, cancel or close this panel.

4,0.0.11948 Cancel

Select a container and click OK. The container is remembered the next time you start Trio.
To switch container, go to Help > Trio Licenses to open this dialog box again.

If there are no containers available, you may need to configure a licenser server. Click
CodeMeter WebAdmin to open the configuration page.

Click Refresh to retrieve available license containers.

3.1.6 Ports

Component Protocol Port Description

trio.exe TCP 6200 Used to execute macro commands of the Viz Trio
client over a socket connection.

trionle.exe TCP 6210 Used by the Graphics Plugin for NLE to utilize Viz
Trio for effect editing.
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3.2 Trio OneBox

3.2.1 Trio Preview Configuration

Traditionally, each Viz Trio system has required two standard desktop PCs to operate: one for the
Viz Trio client and one for its renderer Viz Engine.

3.2.2 Viz Trio OneBox Configuration

You can also run a complete Viz Trio system, including the Viz Engine Program Output, on a single
standard PC (virtualized, desktop or rack mountable) with all of the features of a conventional Viz
Trio setup. Two powerful graphic cards ensure the same graphics quality and rendering speed.
Both the VGA preview and final program signals (playout) can be viewed on the same machine.

Viz Trio setups with more than one Graphical Processing Unit (GPU) may run both preview and
program channels locally. The first time Viz Trio starts and detects more than one GPU, it will
automatically add a Viz Engine host named LocalProgramChannel with host localhost:6800.

& Note: The LocalProgramChannel host will only be created once unless Media Sequencer is
reset.

To simulate a Trio OneBox without the necessary hardware (if you only have one GPU), use the

startup parameter -force_gpu_count 2.

@ Tip: The single PC setup is suitable when you virtualize Trio, or have limited space, such as
in mobile environments (OB vans and remote broadcasts) and small studios.

3.3 Configuration Window

Select File > Configuration to show the configuration window:
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~' Allow Alphanumeric Imports
User Interface
General
rd Shortcurs and Macros + Enable Tabbing

T
P ylist + Enable the numpad
P
L

l -
v Only allow callup codes with numeric values

Output Callup digits 4
Graphic Hub D Automatic look-up of media elements when reading
Pilot Database

D Autoupdate External Pre
Connectivity
D Autoupdate cache for image browser

[ Disable initial loading inth

+ Reload the current page if it is changed in the MSE (from another client or Il

Import/Export Settings

Classic Edition
D lgnore Nameless tabfields during read

[ Create page icons from pr

OK: Applies any changes, and closes the window.

Cancel: Closes the window.

Apply: Applies any changes without closing the window.

Reset: Resets all changes made, unless they are applied locally.

Select the menu item you want to display or change from the list on the left. Use the panel on the
right to review or change setting values:

User Interface

Output

Graphic Hub

Viz Pilot Database
Connectivity

Import and Export Settings

3.3.1 User Interface

The settings below are specific to the local Viz Trio client and do not affect any other Viz Trio
clients using the same Media Sequencer.

This section covers the following topics:
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General

Keyboard Shortcuts and Macros
Text Editor

Page List/Playlist

Paths

Local Preview

User Restrictions

General

To view the General configuration settings, click User Interface > General in the Trio Configuration.

+ Allow Alphanumeric Imports

v+ Enable Tabbing

+ Enable the numpad

+ Only allow callup codes with numeric values
Callup digits 4

[[] Automatic look-up of media elements when reading

[[] Autoupdate External Preview

[[] Autoupdate cache for image browser
D Disable initial loading of icons in the pooleditor

+* Reload the current page if itis changed in the MSE (from another client or [l

Log lewvel

Script Loglevel

Allow Alphanumeric Imports: Enable or disable import of scenes with alphanumeric names.
When disabled, only scenes with numeric names will be allowed.

Enable Tabbing: When enabled, tabbing will iterate through the tab-fields of the element
currently read.

Enable the numpad: When enabled, the numpad will type directly into the callup field.
Holding down the CTRL button disables this function.
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Only allow callup codes with numeric values: When checked, this setting will only allow
callup codes with numeric values when a page is read or saved. When unchecked, this
setting will allow all values.

Show Tabfield List: Select this option for the tab field list to be visible.

Callup digits: Sets the width of the two callup code edit fields on top of the Trio main
window. Selecting 8, for example, will produce a wider code field while selecting 2 will
produce a narrow code field. This setting has no impact on page name length.

- Automatic look-up of media elements when reading: When enabled, this option will
automatically display the video in the video search area when a video element is read. Note
that this will slow down the reading of the element.

- Autoupdate External Preview: When selected, the external preview channel will be
automatically updated when a page is edited in the Viz Trio client. When not selected, the
external preview channel will only update its preview when the page is saved.

- Autoupdate cache for image browser: When enabled (default), the Viz Trio client will update
the local image browser cache automatically and add any images that are new and update
those which have changed. With very large image trees this update process might slow down
the system response. To achieve better system response when the image tree is very large,
disable this option.

Disable initial loading of icons in the pooleditor: When enabled, this setting will prevent the
Viz pool browser from being loaded the first time a tab field, with for example Viz
geometries or images, is selected. The icons are loaded when clicking in the browser or
changing the path.

Reload the current page if it is changed on the MSE (from another client or II): If this setting
is on, the currently read page is reloaded (read again) if it changes on the server.

Loglevel: Defines what kind of log messages that should be logged. Possible levels are: 0, 1,
2, 5, and 9. For more information, see Logging in Viz Trio.

Script Loglevel: Sets which log level to use when running scripts. It defaults to -1 , which is
no logging. So if a script triggers a viz command, the script log level must be set to 9 to see
the Viz Engine command in the log file.

Onair Password: Sets an on-air password. When set, all users will be prompted for the
password when trying to take a Viz Trio client off or on-air.

- Viz World Maps Editor: Defines the Viz World Map Editor (WME) to be launched when a map
is added to the template. For more information on how to work with maps, please read the
Viz World User Guide.

& Note: The WME component requires a Viz World Client installation locally and a
connection to one or more Viz World Servers or a Server Allocator.

Lite Edition (Inline): This embedded Map Editor has reduced functionality for map
selection.
Classic Edition: Classic is the default editor. All the map features are exposed and the
user has full control over the map selected.
- Second Edition (SE): Second Edition is the next generation map editor.
Ignore Nameless tabfields during read: When enabled, this setting will discard error
messages for tab fields with no name.
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Create page icons from preview when saving Trio pages: Store a small thumbnail of the page
in Media Sequencer. The thumbnail will reflect what is in the preview renderer. Do not use
this mechanism as default for large shows, as Media Sequencer is not designed for extensive
storage of binary data. To store specific page thumbnails, for instance if the default
thumbnail is not good enough, send the command page:save_thumbnail in the Trio
Commands page.

Keyboard Shortcuts and Macros

To view the Keyboard Shortcuts and Macros configuration settings, click User Interface > Keyboard
Shortcuts and Macros in the Trio Configuration.

Keyboard Shortcuts and Macro Settings

Cerl+F2
Ceri+F1

Activate the previous

Ctri+F5 Show the vi e browser for the current tabfield.

(rri+FA Show the i dmatnhase hrivweer for the rirrent t

Add Macro Add Script

In this section, keyboard shortcuts can be defined for various operations These shortcuts are
global, which means that they are valid for all page folders. Local keyboard shortcuts can be
specified per show by adding keyboard shortcuts and macros under the Show Properties.

Import and Export: The Import and Export function can be used to import and export
shortcut settings to and from an XML-file for backup and reuse of typical configurations.

& Note: The keyboard file has a *.kbd file extension.

Add Macro: allows an operator to write a Viz Trio macro command, and link it to a shortcut
key.

Add Script: allows an operator to write a Visual Basic script, and link it to a shortcut key.

If a key combination is already in use, you are given the option of overriding it. This will
leave the other command without an assigned keyboard shortcut.

Macros and scripts that are custom made can be removed using the Remove button. Select the
custom made shortcut and click Remove.

& Note: No warning is issued when performing this operation.
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© IMPORTANT! Avoid using SHIFT as part of a command as this will disable the possibility to

use the assigned key when writing characters (e.g. in upper case).

Usage hints for the default keyboard bindings:

- CTRL + N and CTRL + P are default bound to tabfield:next_property and
tabfield:previous_property. They can be used to navigate between several tab-field
properties under one tab-field, for example when working with text and kerning.

- CTRL + TAB and CTRL + SHIFT + TAB can be used to move keyboard focus around inside the
tab-field editors.

- TAB and SHIFT + TAB can be used to move keyboard focus around as if the page editor is not
active or no page is read.

Text Editor

To view the Text Editor configuration settings, click User Interface > Text Editor in the Trio
Configuration.

The text editor contains general settings related to text formats and how to replace key
characters.

General

General

+" Use CTRL+A Selection

D Support unicode text-selection

Text import format UTF8

Use CTRL + A Selection: When deselected, the normal key combination for selecting all text,
CTRL + A will be disabled.

- Support Unicode text-selection: Use this setting to enable or disable support for Unicode
text-selection. This option is used if the default language for non-Unicode programs in
Windows is set to a Unicode language. For example: If copying text from a text editor that
by default does not support Unicode language into Viz Trio. The representation of text
would not be correct.

- Text import format: This option allows a character set to be specified for text imported and
interpreted by Viz Trio. By default this is set to UTF-8.
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Word Replace

s when the command " how_replace_list" is executed. The editor will match the previous
haracters that are con d.

Import from XML

Export to XML

MNEWS

Remove

et the format of which the imported text will be interpreted as.

Word replace allows key characters to have replace words defined. The list of replacement options
becomes available in the text editor when running the text:show_replace_list command, see
the User Interface section for how to define keyboard shortcuts.

The text editor matches the typed character with the list of key characters configured, and displays
the corresponding replacement list. The word correction function is case sensitive, making it
possible to define replacement options for both lower and upper case letters. The list of word
correction options is local.

Key characters: Shows a list of defined replacement key characters.

Correct options: Shows a list of a key character’s corresponding replacement options.
Add: To add Correct options, a key character must be added first. To add Correct options,
select the key character, and click the associated Add button.

Remove: Select a list item to remove, and click the associated Remove button.

Folder: Imports a predefined list exported to an XML file.

Save: Exports the predefined list to an XML file.

Example

<entry name="customcharacters">
<entry name="A">
<entry name="CBS"></entry>
<entry name="CNN"></entry>
<entry name="BBC"></entry>
<entry name="ITN"></entry>
<entry name="NBC"></entry>
<entry name="NRK"></entry>
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<entry name="YLE"></entry>
<entry name="SVT"></entry>
<entry name="CCTV"></entry>
<entry name="TV2"></entry>
<entry name="ZDF"></entry>
<entry name="RTL"></entry>
</entry>
</entry>

Page List/Playlist

To view the Page List/Playlist configuration settings, click User Interface > Page List/Playlist in the
Trio Configuration.

General

[[] Hide empty locked groups

nt in playlist or pagelist after read.
Remove MOS-playlists from show
D Automatically reactivate playlists when profile changes
+" Automatically activate show when cpening
D Use Preview Server to load thumbnails

Cursor

[] Autopreview (single-click read)

[] Autocenter cursor

General Settings

Hide empty locked groups: This setting will prevent locked groups with no pages from being
displayed in the page list.

Select next element in playlist after read: When enabled, the next element in the playlist will
automatically be selected after a read operation.

Remove MOS-playlist from show: Removes newsroom playlists that are monitored using the
MOS protocol when the show is closed. Setting this to Yes will also affect other clients
connected to the same Media Sequencer. The available options are: Yes, No and Ask.
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Automatically reactivate playlists when profile changes: If enabled, active playlists are
reactivated when the current profile is changed.

Automatically activate show when opening: If selected, automatically activate the show when
opened. Please be aware that this option, if used, could put a high load on the Media
Sequencer.

Use Preview Server to load thumbnails: If selected, use Preview Server to load thumbnails.

Cursor Settings

Autopreview (single-click read): When enabled, a page will be read as soon as it is selected.
Autocenter cursor: With this function enabled, the cursor will have a static position when the
page list is longer than the Page List window. In these situations the window is provided with
a scrollbar on the right side. With Autocenter Cursor enabled, as long as some pages are
hidden in the direction the list is browsed, the cursor will remain static and the list items will
move instead. When the last item is revealed, the cursor will start to move again.

Paths

To view the Paths configuration settings, open File > Configuration > User Interface > Paths in the
Trio Configuration.

This section describes the directories settings for several functions. All settings are local to the
specific Viz Trio client.

Paths Configuration Settings
Awi Path
Dif Path
Image Path
Audio Path
Script Path

Trio Logfile Path

MSE As-Run Logfile

Shared Temp Path

Help Path

Avi Path: Sets the default location when browsing for AVI files.
Dif Path: Sets the default location when browsing for DIF files.
Image Path: Sets the default location when browsing for Image files.
Audio Path: Sets the default location when browsing for Audio files.
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- Script Path: Sets the default directory to file-based scripts that may be assigned to a Viz Trio
show and/or template.

- Trio Lodfile Path: Sets the path to the directory where the Viz Trio client should store log
files. For more information, see To change the Viz Trio log file path.
MSE As-Run Lodfile: Sets the path to the Media Sequencer as-run log file. This log file offers
a Media Sequencer logging mechanism for all elements that have been taken on air. The as-
run log file is an additional debugging tool which a Viz Trio administrator may want to
enable to verify that the communication between Media Sequencer and the playout engine is
working properly. The file name may be given with either relative or absolute path.

A Note: This is a global setting, affecting all clients connecting to the specified Media
Sequencer. Also note that the as-run log file ends up on the Media Sequencer host,
not on the local Viz Trio machine. Read more about the as-run log file in the Media
Sequencer documentation at http://<mse-host>:8580/mse_manual.html#as-run-log.

- Shared Temp Folder: Used for temporary files when importing or exporting Viz Trio shows
on an external Viz Engine. This must be a network share that is both accessible for the client
and the external Viz Engine.

Help Path: Sets the path for the main help file. Help will be opened when pressing F1 or
when clicking View Help under Help in the main menu.

Local Preview

To view the Local Preview configuration settings, click User Interface > Local Preview in the Trio
Configuration.
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Local Preview Configuration Settings

General

Viz Engine connection timeout

Font encoding

D Single layer transition logic preview

v Use animation when previewing transitions logic elements
Local Preview Resolution
(O PAL(720x576)

(O NTSC (720x480)

Viz Engine connection timeout: Sets the number of milliseconds until the local Viz Engine
renderer times out. Changes to this setting requires a restart of Viz Trio.

Font encoding: Sets the font encoding format of text sent to the local preview. This setting
overrides the local Viz preview and requires a restart of Viz Trio to take effect.

& Note: This does not have an effect on remote Viz Engines; hence, the font options
for Viz must be set accordingly. Also note that the Viz Trio interface only supports
the font encoding set for the operating system under the Regional and Language
Options settings (i.e. support for complex script, right-to-left and East Asian
languages).

Single layer transition logic preview: Enable previewing of single-layer pages in the
background scene. If this setting is disabled, only Combo pages will be previewed in the
background scene.

Use animation when previewing transitions logic elements: If this setting is off, the
transition logic animation will be skipped in the local preview. This requires that each
foreground scene defines a "pilot1" tag on a director. By default, this setting is on. In the
Local Preview Resolution section the aspect ratio for the local preview window can be set,
and the systems refresh rate defined (normally 50 for PAL and 60 for NTSC).

User Restrictions

To view the User Restrictions configuration settings, click User Interface > User Restrictions in the
Trio Configuration.
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User Restriction Settings

Do not allow users to:

scripteditor

O O

name shows

O

O
O OO0 0O<« <000 OOoOoOogs

The User Restrictions section lets an administrator deny the operator from performing certain
actions in Viz Trio.
Page:

Delete Templates: When checked, prevents the operator from deleting templates from
the show. Command: show:delete_templates.
Direct Takeout Pages: When checked, prevents the operator from issuing a direct take
out command on pages in a show. This also disables the context menu option for the
show. Command: page:direct_takeout.
Direct Takeout Pages from a Playlist: When checked, prevents the operator from
issuing a direct take out command on pages in a playlist. Command:
playlist:direct_take_out_selected.
Rename pages: When checked, it is not possible to rename saved pages in the page
list.
Save values to linked databases: When checked (default), prevents the operator from
saving values back to the database.
Takeout Pages: When checked, prevents the operator from using the Take Out
command. This also disables the Take Out button in the Page editor. Command:

page:takeout .
Post Rendering:
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Enter new hostnames in post render view: When checked, prevents the operator from
adding new hostnames to the Render Videoclip editor.

Scripts:
Edit scripts: When checked, prevents the operator from editing the script using the
Edit Script button in the Page editor. Command: gui:show_scripteditor .

Scroll Editor:
Create new scroll templates: When checked, prevents the operator from creating new
scroll templates. Command: gui_show_scroll_template_creator .

Shows:

- Access Show Properties: When checked, prevents the operator from accessing the
Show Properties. Command: gui:show_settings.
Browse external playlists: When checked, disables the Playlists tab under Toolbar, and
consequently preventing the operator from browsing for playlists on Media Sequencer.
Browse viz directories when changing shows: When checked, disables the Viz
Directories tab under Toolbar, and consequently preventing the operator from
browsing the Viz directory to set a show path.
Create or rename shows: When checked, prevents the operator from creating new
Shows or renaming existing shows.
Delete all pages in a show: When checked, prevents the operator from selecting and
deleting all pages in the show in one operation. Normal page by page and page group
deletion is still possible.
Open the window for importing templates into a show: When checked, prevents the
operator from importing new scenes from Graphic Hub (Viz 3.x) or the data root (Viz
2.X).
- Trio:

Call Viz Trio Commands: When checked, prevents the operator from manually calling
Trio Commands. This does not prevent scripts from doing the same. Command:
gui:show_triocommands . See Working with Macro Commands.
Cleanup External Renderers: When checked, prevents the operator from issuing a
cleanup renderer command. Command: trio_cleanup_renderers.
Switch to Viz Artist: When checked, prevents the operator from switching to Viz Artist
mode. Command: gui:artist_mode.

3.3.2 Output

To view the Output configuration settings, click Output in the Trio Configuration.

Copyright © 2023 Vizrt Page 30



Viz Trio User Guide - 4.0

Output Configuration Settings

User Interface
G al

Shortcuts and Macros

Qutput
Graphic Hub

Pilot Database

Profiles

default
New Profile
hey

Local Wall

superdemo

MNew Profile

Device Channels Viz Engines

2 localhost:6100

Name

- Owm p-superdemo:6100

A
L vmp-superdemo:6300
K atw-laptop:6100
[2localhost:6100
* [2 localhost:6100
L2 localhost:56000

B L2 localhost:56001

* O vmp-superdemo:6100 Add Viz
= Video Devices
* 00 vmp-superdemo:6800 lmatw-lapmp'ﬁmﬂ
LocalProgramChannel ._m localhost:56000 (Clip, ChO)
* [2 localhost:6800 F‘DC&MDSESGO[H (Clip, Chj)

[ | vmp-superdemo:6100

MNew Channel Add Video...

A key feature is the ability to create profiles for different purposes. For example, Profile Setups can
be created where different channels have the program and preview function. This makes it fast and
easy to switch between different output settings.

Profiles can be defined with different program and preview channels in the Output channels
section. It is most common to define a studio with channels mapped to renderer machines (Viz

Engine hosts).

Viz Trio supports four methods to resolve which channel is the local program channel. If an
unsupported method is used, the Connection Status button will not appear in the Status Bar.
Consequently, the operator will not be able to control the local program channel status.

Resolving the Local Program Channel Name

Method

localhost

‘I 27.*'7':'3‘:

Hostname

IP

Comment

For the program channel; remember to add the port 6800.
Not only 127.0.0.1 refers to localhost.

Name of computer without domain.

The computer’s IP. If the computer has multiple IPs (e.g. it has
multiple network cards), it may still fail.
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© IMPORTANT! Although the computer may have several names (for example in /etc/hosts),
only the NetBIOS name can be used (the name obtained when running the "hostname"
command). It is not possible to add the domain (for example
<hostname>.domain.internal).

This section covers the following topics:

Program and Preview Channels
Profile Setups
Forked Execution
- Working With the Profile Configuration
Upgrading Old Profiles

Program and Preview Channels

Local preview is Viz Trio’s embedded render window in the lower right corner, which always shows
the last page read. Local preview displays graphics as WYSIWYG (what you see is what you get)
when editing a page. Text and images change immediately as text and images are added to the
page. Select which elements to edit using point and click directly in the render window.

External preview (optional) is a separate Viz Engine renderer with its own reference monitor that
displays a true preview. External preview shows how the program channel will look before a page
is taken to air.

Program is a separate Viz Engine renderer that renders the content that is taken on-air.

Profile Setups

Profile Setups

Profile Program Preview
Main A (Viz 1) B (Viz 2)
Backup B (Viz 2)

Two-channel Setup

A typical profile setup is a two-channel setup, program and preview, with one render engine
assigned to each channel. A more advanced setup is the use of forked execution. As the term
suggests, forked execution is a way to configure a single output channel to contain multiple
render engines.

Profiles are used to create different setups, for example in a backup configuration where a switch
from a main renderer to a backup is needed. If two output renderers are named A and B, where A
is program and B is preview, a profile named "Main" will then have channel A=program and
channel B=preview.

If the renderer that is acting as program (A) in the "Main" profile fails, a profile named "Backup”
could have channel B=Program.
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GPI

Control playout through a General Purpose Input (GPI), for instance through hardware such as a
vision mixer.

When GPl is enabled, the external cursor (the GPI system’s cursor) will be displayed in any client
that is using the same profile as the external system. A typical setup would be that one Viz Trio
client is in the same profile as the GPI system, and functions as a "prepare station” for the
producer at the vision mixer desk. Data elements are then made ready and displayed on a preview
visible to the producer, and the elements are then triggered from the vision mixer.

A Note: This configuration requires a separate "GPI" profile that is not used by other control
application clients. Other clients can be in other profiles and produce content to the same
output channels. However, they need to be on other transition layers or on another Viz
layer so that they will not interfere with the graphics controlled by the external system.

A channel can be designated as a Program or Preview channel by selecting the appropriate check
box. The program and preview channels are reciprocally exclusive - only one channel can be set to
program, and only one channel can be set to preview. For example, if A is set as program and B is
set to preview and C is set to program, A will no longer be set as program.

When configured to use video in graphics from a video server (for example Viz One), it is currently
recommended to use IP addresses for both the Viz and Video channels in order to visualize the
transfer progress correctly; hence, a hostname on the Viz channel will work, but not on the Video
channel. They must also match the video configuration for both program and preview.

The Video device configuration is used when configured to trigger video elements in a video server
setup.

© IMPORTANT! Current limitations require that both graphics and video channels use an IP
address.

Forked Execution

Forked execution can be used with standalone and transition logic scenes, and replaces the
execution of visible containers.

This section covers the following topics:

Standalone scenes
Transition logic scenes
Visible containers

Standalone Scenes

Forked execution supports standalone scenes by executing the same graphics with different
concepts on two or more render engines. Concepts are defined per channel when Working With the
Profile Configuration tool.

As an option you can also use this setup to handle fail situations by having the same graphics
concept rendered on both engines.
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Transition Logic Scenes

As with Standalone scenes, forked execution supports setting concepts for Transition Logic
scenes. In addition Transition Logic scenes, by defining channels with different render engine
setups, can show different states of the same scene on a per engine basis. All states are
synchronized for all engines (at all times) in order to achieve an artifact-free and smooth morphing
of the graphics from one state to the other.

For example, if you have three render engines you can set up a range of channels with different
combinations of render engines per channel.

Channel Viz Engines
A 1,2,3

B 1,3

C 1

D 2,3

E 2

For example, if a scene has four layers, each layer can be controlled separately from the other
layers (see table below). By setting a state per layer you can achieve a varied output depending on
the channel used and how that channel is configured in terms of render engines (see table above).

Layer 1: Shows and hides a geometry (e.g. a cube)

Layer 2: Shows and hides some text

Layer 3: Positions the geometries

Layer 4. Animates the layer 1 geometry by showing the next image or a logo

States for Layer 1 States for Layer 2  States for Layer 3  States for Layer 4

Show cube Show text Position left Next image

Hide cube Hide text Position right Show logo

<ignore> <ignore> Position center <ignhore>
<ighore>

With the scene layers and configured channels above you can have the following output on each of
the three engines:
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Channel C(Viz 1)

Channel D(Viz 2,3)

Channel E(Viz 2)

Channel A(Viz 1,2,3)

Channel A(Viz 1,2,3)

Channel A(Viz 1,2,3)

Channel A(Viz 1,2,3)

Channel B(Viz 1,3)

Channel E(Viz 2)

Visible Containers

Layer State

Show cubePos leftShow textShow
logo

Show cubePos rightShow

TextShow Logo

Pos centerHide text

Next image

Next image

Show textNext image

Show logo

Hide cube

Hide cube
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Although it is considered deprecated, a behavior similar to that of forked execution is supported.
By designing a standalone scene where each root container is a variant of the other, you can
configure each render engine to render specific containers (by name). In effect, a scene with two or
more root containers can have one or more containers assigned and rendered visible by a single

render engine.

& Note: Due to potential performance issues when using large textures (e.g. HD), this option
is no longer recommended. Concept and variant design of standalone and transition logic
scenes is therefore the recommended design convention.
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Working with the Profile Configuration

This section covers the following topics

Profile Configuration:

- To open the profile configuration
- To add a new profile

- To rename a profile

- To delete a profile

Channel Configuration:

- To add an output channel to the Channels list

- To rename an output channel in the Channels list

- To remove an output channel from the Channels list

- To add an output device to the Channels list

- To remove an output device from the Channels list

- To add a concept override for a channel output device

Output Device Configuration:

- To add a Viz Engine

- To add a video device

- To edit a Viz Engine or video device

- To delete a Viz Engine or video device
- To enable scene transitions

- To enable still preview

Profile Configuration

To Open the Profile Configuration

1. Click the Config button (upper left), and then select Output.
2. Right-click the profile on the status bar (lower-left) and select Profile Configuration... from
the menu.

To Add a New Profile

In the Profile Configuration window, click New profile, enter a new unique profile name in
the text field and press Enter.
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To Rename a Profile
1. Right-click the profile and select Edit Profile Name or simply double-click the profile and
enter a hew name.
2. When finished editing the name, press Enter or click outside the Profiles list.

To Delete a Profile

Right-click the profile and select Delete Profile, or simply select it and press the Delete
button.

Channel Configuration

To Add an Output Channel to the Channels List

Viz
Program Preview

Videao

Name Program Preview

Click New channel or drag and drop a Viz Engine or video device to the Channels list.

To Rename an Output Channel in the Channels List

Right-click the channel and select Edit Channel Name from the menu or double-click the
name.

To Remove an Output Channel from the Channels List

o Wiz Video
Program Preview | Program Preview

Channel Edit Channel Name = O

» B VizEnginel Delete Channel

» B VizEngine2

Right-click the channel entry and select Delete channel from the menu or select the channel
and press the Delete button.

To Add an Output Device to the Channels List

Simply drag and drop a Viz Engine or video device onto the channel in the Channels list, or
select it and select Add to profile (for creating a new channel) or Add to selected
channel from the menu.
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To Remove an Output Device from the Channels List

Right-click the Viz Engine or video device and select Delete Output from the menu or simply
select it and press Delete.

To Add a Concept Override for a Channel Output Device

It is possible to override the concept on Viz Engine output level. This concept override will take
precedence over concepts set in the show or on the playout elements.

¥ O vmp-superdemo:6100

Concept: SPORTS

* O vmp-superdemo:6800
Concept: NEWS

1. Expand the channels output device and append the concept name. This will override any
concepts set elsewhere.
2. Click OK.

© Caution: Note that concept names are case sensitive.

Output Device Configuration

Adding a Viz Engine
Configure Viz Engine

Hostname vizenghost

Port 6100
Super Channel
Mode Standard

Asset Storage

Delay 0

¥ Deprecated Settings
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1. Click Add Viz... in the Profile Setups window to open the Configure Viz Engine dialog box.

2. Enter the Hostname.

3. Default port for Viz Engine is 6100 or 56000 for Super Channels.

4. Optional: Select Mode.

5. Select whether the video device is a regular or controlled through a Viz Artist Super Channel
plugin.

6. Set a delay (optional).

7. Optional: Select an Asset Storage location. Asset Storage lists available Viz Engine clip

transfer and playout destinations.
8. Click OK. A status indicator will show if the renderer is on-air.

Adding a Video Device

Configure Video Device

Type Viz Engine ¥

Port 6100

Super Channel
Aszet Storage
Delay

Fullscreen

Clip Channel

Use Transitions

Alternate Clip Channel H

Fullscreen Scene

Cancel

f—

. Click the Add Video... button in the Profile Setups window to open the Configure Video
Device dialog box.

Select the video server Type.

Type the Host or IP address.

Enter the Port number (optional).

Select whether the video device is a regular or controlled through a Viz Artist Super Channel
plugin.

Set a delay (optional).

Select a publishing point from the Asse